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Mod Magenta Concord

Merge 

Data

Release 

Version

General Added the EZ Form Design Wizard. M X X 6.00

General

Added new Change Form Color option to the Format menu to allow the user to change the form 

color of all the fields on the form at the same time. M X X 6.00

Response Changed the Default Response Ink from Gray 55% to Gray 50%. M X X 6.00

Response Program now checks for Non Bubble Characters in the replacement characters. M X X 6.00

Response Bubble Density error messages were modified to be more accurate. M X X 6.00

Text Removed bogus fonts from font lists that start with the @ symbol. M X X 6.00

Image Region

Image Region field changes would not be saved if the changes were made before the field was put 

on the workspace.  The Browse button would cause the software to end abnormally. B X 6.00

Version 6.00

Graphic The program was modified so a pasted bitmap could be properly added to the form. B X X 6.00

Printing Modified the entry boxes for beginning and ending Lithocodes to look different to avoid confusion. M X X 6.00

General Repaired a problem when opening forms with empty back pages. B X X 6.00

Response

Some bubble fonts were removed.  The program will automatically select the new correct font when 

old forms are opened. M X 6.00

Paste

The message “Do you want to paste into the selected field?” was shown when a Response object is 

selected.  Since a new Response object is always created, the question should not have been 

shown in the first place. B X X 6.00

Paste

Added the field type to the error message warning about pasting into a selected field to make it 

more accurate. M X X 6.00

Colors Removed unneeded Gray Scales and generally cleaned the color list. M X X 6.00
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General Modified “Load Character Map” to “Font Viewer” on the View menu to be more descriptive. M X X 6.00

General Added form backups to the program in case of problems with the form files. M X X 6.00

Scanning

Modified the program so the scan template will be automatically created when you click on Launch 

the Template Editor if it does not exist. M X X 6.00

Scanning

Modified the program so the scan template will be automatically created when you click on “Scan 

Forms” if it does not exist. M X X 6.00

Scanning

Modified the program to issue an error if you click on “Scan Forms” before you have created the 

scan template. M X X 6.00

Scanning

Changed the identification information to row and column number for the SetupOrderofOutputFields 

feature on the Scanning menu. M X X 6.00

Scanning On the Scan Properties dialog box, the Values column no longer appears when the field is Numeric. B X X 6.00

Colors Changed all default colors to Black/Gray and added an Warning for Response colors over 60%. M X X 6.00

General Removed all 6 rows or columns to the inch. B X 6.00

Data Merge

Repaired problem where if a comma or tab field was too long, it would continue to fill out grid that 

did not exist. B X X X 6.00

Response

Program now gives an error if the user does not fill in the Bubble and Barcode field names on the 

Properties dialog box. M X X 6.00

General Strengthened warnings about changing bubble density. M X X 6.00

General Removed the .bkt file extension - all forms, single page or multi-page, use the .fsl extension. M X X 6.00

General Added Double sided margin set. M X X 6.00

Data Merge

In Data Merge, for Multiple Characters, automatically puts the current labels in the entries which can 

then be modified. B X X X 6.00
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Scanning

Modified Scan Field Properties to Link properties button and added Data Merge tab for a linked 

Response object. M X X 6.00

General Added “Upgrade Version” to all menus. M X X 6.00

Data Merge The “Number of Copies Field” warning message would come up erroneously. M X X X 6.00

General Added checks for illegal characters in Field Names. B X 6.00

Error Messages Certain error messages were being shown on the screen when using the CLI. B X X 5.08

Linking Repaired a problem where the software would exit abnormally if certain field types were linked. B X X 5.08

Lines Corner type was showing up incorrectly on the Object Bar for Lines. B X X 5.08

Version 5.08

Linking

Modified the way linking takes place for List type fields.  The software now uses the orientation of 

the scan field to determine whether numbering is left to right or top to bottom. M X X 5.08

Form Files Adding extra checking when saving form files to network drives to stop some save errors. M X X 5.08

Tools Changed the Tools menu item "Renumber Reponses” to “Renumber Text or Reponses”. M X X 5.08

Graphs Repaired a problem where the graphic would disappear from the screen. B X X 5.08

Operating 

System Modified the software to accommodate changes in Microsoft Windows Vista. M X X 5.08

Setup Removed "Change Colorset" command. M X X 5.08

Paper Size Made some modifications to allow better usage of 11 x 17 paper. M X X 5.08
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Timing Track Repaired incorrect Timing Mark placements (Right, Bottom) when form is not 6x6 or 48 columns. M X 5.08

Data Merge Add the ability to preslug a bubble where there is more than 1 character to match in the data field. M X X X 5.07

Data Merge For Data Merge, made case (upper or lower) of text moot. M X X X 5.07

Data Merge In Data Merge, corrected the Data Length calculation in certain circumstances. B X X X 5.07

Responses

Repaired a problem where the proper Row and Column Gap was not being calculated when 

creating a new Response field. B X X 5.07

Barcodes

Repaired a problem where Magenta would exit if you selected an unlinked barcode, then, clicked on 

the Scanning tab. B X 5.07

Lines Corner type was showing up incorrectly on the Object Bar for Lines. B X X 5.07

Version 5.07

Printing Print Multiple was active in cases where it should not have been. B X X 5.07

Printing

If Magenta OMR version and no Timing Track was present, the setting of margins was not working 

properly. B X 5.07

Scanning

Repaired problem where the Scan properties were not being correctly set up for other fields in a 

link. B X X 5.06

General

Repaired a problem so the controls would get set correctly for Landscape forms when changing to 

Landscape. B X X 5.06

Alignment

Changed Move Print Image with booklet open, to not ask about changing all pages if only one page 

open. M X 5.06

General Reduced the number of Timing Marks to 83 for 8 per inch.  Makes for easier form alignment. M X 5.06

Version 5.06
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Alignment Changed Alignment procedure. M X 5.06

Responses Added “Select All Response Objects” to Edit menu. M X X 5.05

Booklets Added ability to open a form and booklet. M X X 5.05

Scanning

On the Scanning Tab of the Field Properties dialog box, made Respondent ID and Grade always 

active. M X X 5.05

Booklets Repaired File/SaveAs rename problem B X X 5.05

Booklets

An erroneous error message about what kind of form (Magenta or Magenta for Office) was being 

opened was appearing. B X X 5.05

General If no values in HKEY_LOCAL_MACHINE registry section, Magenta would not start up. B X X 5.05

Version 5.05

Booklets Repaired all problems in file saving routines. B X X 5.05

Scanning

Repaired a problem where a “…Not enough fields…” error message was appearing incorrectly for 

Scan Field Types ALLTHATAPPLY and BOOLEAN B X X 5.05

Scanning Repaired a problem where the Scan Field Type was not being set for certain link types. B X X 5.05

Scanning Repaired a problem the Boolean field was not being set up correctly in the scan template. B X 5.05

Predefined Fields Predefined fields - made the 0-9 and A-Z grids more flexible. M X X 5.05

Shading

Modified the “…do not use shade colors greater than 10%..” error message to only come up when a 

Shade object is touching a Response object and to 10%  from 5% and to only come up once when 

changing the color of multiple Shade objects. M X X 5.05

Booklets Add the ability to save an .fsl as a .bkt to convert a form to a booklet. M X X 5.05
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Scanning

Repaired a problem where Shade, Lines and Boxes were being incorrectly checked for fields 

between bubbles. B X 5.05

Scanning Repaired a problem where the Respondent ID variable was not getting set in the scan template. B X X 5.05

Scanning

Repaired a problem where some fields were not getting their Scan parameters set correctly before 

they were saved to the form file. B X X 5.05

Booklets When opening a Version 5 booklet, some files caused an erroneous conversion message. B X X 5.05

Responses

On the Field Properties dialog box, General tab, removed some erroneous errors for 0 entries in the 

Number of Rows or Columns. B X X 5.05

Add Colors Repaired some problems when adding colors. B X X 5.05

Scanning

Added  “Unnamed Fieldn” auto-naming fields so the user can use those names to more easily 

identify unnamed fields. M X X 5.05

Scanning Added Row and Column to more easily identify some fields. M X X 5.05

Scanning Added Textual or Numeric to the Scan Properties dialog box. M X X 5.05

Booklets

If the pages of a booklet get converted before opening the booklet, Magenta now opens the booklet 

correctly anyway. M X X 5.05

Responses Removed Bold and Italic buttons from Response Object Bar and Properties dialog box. M X X 5.05

Response 

Bubbles Add 1-10 and 1-12 to Response Values list. M X X 5.04

File Saving FileSaveAs did not work if you saved form into another folder. B X X 5.04

File Saving

When doing a FileSaveAs with a fsl/bkt file,  any .bmp files specified in the .fsl would not be saved 

in the new .fsl/bkt file. B X X 5.04

Version 5.04
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Scanning Set up Boolean fields as Multi-question. B X X 5.04

Scanning Repaired a problem where the rows or columns for Boolean fields were not be set correctly. B X X 5.04

Colors Modified “NO FONT or INK” error message. M X X 5.04

Colors Changed the word “Ink” to “Color” throughout the program. M X X 5.04

Scanning On Scan Field Properties dialog box, adding blank rows for Questions was not working properly. B X X 5.04

Scanning

When creating the scan template (.omr) and a field is to be graded, blanks should return “Nothing” 

not “blank”. M X 5.04

Scanning Repaired a problem concerning single bubble fields and combining. B X X 5.04

Renumber 

Responses Modified Renumber Responses so it would sort by position only on form. B X X 5.04

Printing Repaired Merge Data printing issue with booklets. B X X X 5.03

Aligning Text

Repaired a problem where Magenta exited if you attempted to “Align Text to Responses” with no 

text fields selected. B X X 5.03

Printing Added the ability to print a single page. M X X 5.02

Printing

When printing a duplex booklet, an error message about printing in duplex was showing up 

incorrectly . B X X 5.02

Version 5.03

Version 5.01

Version 5.02
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Scanning

Changed the .rco file to set the “Use Default Names” parameter to ON (Field Properties - Advanced 

tab). M X 5.01

Booklets

If you had multiple pages in a booklet and were printing without Duplex on, you got a warning 

message for every page (making PDF). B X X 5.01

Autosave  An Autosave feature was added. M X X 5.0

Barcodes

Modified the way a Text Object is set to be a Barcode field.  Instead of checking the box labeled 

"When scanning, this is a Barcode Field:" on the General tab of the Field Properties Dialog Box, you 

now set the Scan Field Type to BARCODE on the Scanning tab of the Field Properties Dialog Box. M X X 5.0

Barcodes The scan field type will be set to BARCODE if the word "barcode" is in the font name. M X X 5.0

Barcodes Added error message to prevent turning a Text Object into a Text Box if the field is set to barcode. B X X 5.0

Booklets

Modified the way forms and booklets work - there will now be only one file (.bkt or .fsl) that will 

contain the .bkt, .fsl and .bmp files. M X X 5.0

Version 5.0

Booklets

When you create a new booklet, Magenta now opens the first page instead of the Booklet Dialog 

Box. M X X 5.0

Booklets

Added the options “File/New/Front Page” and “File/New/Back Page” to the File Menu, to add forms 

to a booklet. M X X 5.0

Booklets

Added “Insert Form” option to the Booklet Dialog Box to allow users to added forms created as 

separate forms into a booklet. M X X 5.0

Booklets

Added “Copy Form” option to the Booklet Dialog Box to allow users to save a form to an .fsl file 

outside a booklet. M X X 5.0

Booklets

When saving a booklet, the question asking if you wanted to close the booklet was being asked 

twice. 

B X X 5.0

Copying

When copying a Text object the Text will be set back to the default "abc".

M X X 5.0

Edit Inks New colors - Brown, Peach - were added. M X X 5.0
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Error Messages

Added the error message “All forms in a booklet must have the same orientation (Portrait or 

Landscape)" if you try to create a form with a different orientation. B X X 5.0

Error Messages When loading a file with links, erroneous missing Timing Marks messages were removed. B X 5.0

Error Messages Modified shade error message to read 5% for Magenta Office forms. B X 5.0

Error Messages

When using SquareNormal, etc. fonts, an incorrect error message that the form was created using 

standard version was given. 

B X 5.0

Field Labels

When adding a field, if the field label was changed before it was placed on the workspace, the 

changes are lost when the field is drawn on the work space. B X X 5.0

Field Labels When loading a barcode field, the field label would be lost. B X X 5.0

Field Labels

Right click did not work for fields with the same field label. Also, added extra information to the 

descriptions of fields. 

M X X 5.0

Images Hyphens and underscores are now allowed in Graphic file names (.bmp). M X X 5.0

Installation Form files (*.fsl) and image files (*.bmp) are now moved to the new folders. M X X 5.0

Installation

In the form files (*.fsl), references to the Images folder for graphics are now updated to reflect the 

new Images folder. 

M X X 5.0

Merge Data When using Segments and Comma delimited files, a number of problems were repaired. B X 5.0

Move Print Image Added instructions to the Move Print Image Dialog Box. M X X 5.0

Move Print Image When changing Snap to Grid values, they are applied to all open forms, not just the active one. M X X 5.0

Move Print Image

When performing a Move Print Image on a booklet, you are now asked if you want to make the 

same change on all like pages. 

M X X 5.0

Paste Special

Generally, if you put local Magenta fields in the Paste buffer, copies will be made when you paste. 

M X X 5.0
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Paste Special

If you copy text from outside Magenta, it will be copied into a new TextBox. If a Textbox is already 

selected it will be copied into that one. 

M X X 5.0

Paste Special Characters from bubble fonts can be pasted into a selected Response Object. M X X 5.0

Paste Special

Paste Special now allows text such as for questions and labels to be pasted into separate Text 

Objects. 

M X X 5.0

Properties Dialog 

Box

On the Field Properties Dialog Box for a Response Object, General tab, the Number of Rows/Cols 

get properly grayed when not valid. 

B X X 5.0

Responses

The "Stay Away" gray area around bubbles only went around each bubble instead of covering all 

the area in between. 

B X 5.0

Responses

Uneven spacing in Replacement is now allowed. Creating the scan template works with this. 

Uneven spacing is never a Grid. 

M X X 5.0

Responses In Magenta Office only, when Snap to Grid is turned off, the user can pixel move Response Objects. M X 5.0

Linking

The Scan Properties dialog box comes up automatically when you link fields together that have at 

least one Response object. M X X 5.0

Linking

Double clicking on any part of a link will cause the Scan Properties Dialog Box to appear for that 

link. M X X 5.0

Linking

When linking, if you have bubbles with greater than 1 digit inside the bubble (10, 11, etc.), the 

numbers did not get put in the Values area correctly. 

B X X 5.0

Linking Linking with no field labels included can cause a General Protection Fault. B X X 5.0

Scanning

Modified the Scan Properties Dialog Box to be more complete by adding new properties and 

allowing text to be moved around when it is not in the proper category (Question, Label, Other). M X X 5.0

Scanning

On the Reorder Scan Fields Dialog Box, the question text was added to the field to distinguish fields 

that were given the same field label. M X X 5.0

Scanning Added ability to create scan template file (.omr). M X 5.0

Scanning Added “Setup Order of Output Fields” and “Create Scan Template” to the Scanning submenu. M X 5.0
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Scanning Change "Reorder Scan Fields" to "Setup Order of Output Fields". M X

Scanning

On the "Setup Order of Output Fields" dialog box, the question text was added to the field to 

distinguish fields that were named the same thing. M X 5.0

Scanning Added the Scanning tab to the Field Properties Dialog Box. M X 5.0

Scanning

Added the Tools/Image Clip option (also to the Toolbar) to allow the addition of an Image Clip/Input 

field to Remark Office Scan Template M X 5.0

Scanning Added an alignment procedure to align the scan template. M X 5.0

Scanning Added the Scan Properties Dialog Box. M X 5.0

Scanning A 100 scan field limit when using Reorder Scan Fields was eliminated. B X 5.0

Scanning

When “Setting up Order of Output Fields” and some fields were moved, if a field was selected on 

the workspace the program might cause a General Protection Fault when OK was clicked. 

B X 5.0

If the Scan tab on the Properties Dialog Box has been activated for a field, the choices and labels 

Scanning

If the Scan tab on the Properties Dialog Box has been activated for a field, the choices and labels 

were not being recalculated correctly when changes were made. 

B X 5.0

Scanning

On the Reorder Scan Fields Dialog Box, when you move one member of a link, the others will be 

automatically moved. 

M X 5.0

Scanning Modified scan template to set Form ID same on back as on front unless actually different. M X 5.0

Saving Form

When you try to save a form that has objects that have been placed off the workspace, an error will 

be issued and the objects will be put back on the workspace. M X X 5.0

Shading Changed TextBox Background ink from Gray 3% to Gray 8%. M X X 5.0

Shading

The "Stay Away" gray area around bubbles has been changed to cross hatch to help distinguish it 

from regular shade. 

M X 5.0

Text "Replacement Characters" has been replaced with "Response Values or Text". M X X 5.0
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Text Text now centers properly on grid when Snap to Grid is ON. M X X 5.0

Text

Text from one Text Object can now be copied and pasted into anotherTselected Text Object using 

Ctrl-C and Ctrl-V. 

M X X 5.0

Text

Removed changing of text alignment when using alignment tools. This previous modification had 

unintended consequences. 

M X X 5.0

Text  You could not change the font of a Text Object before putting the Text Object on the workspace. B X X 5.0

Text Boxes When loading a form, single line Text Boxes could be several lines tall. B X X 5.0

Paper Size A new paper size was added:  Other.  This paper size allows you to enter any size paper. M X X 5.0

Paper Size Paper Sizes were added when printing so they would be correct in .PDF files. B X X 5.0

Windows Removed “New Window” from the Windows submenu. M X X 5.0

Defaults Changed Default Background ink to default to the last chosen and other changes M X X 4.11

Error Messages When opening a form, the main window was not drawing if an Error Message Box was displayed. B X X 4.11

Lines

For Windows 95/98/me Line types were showing up as all solid – dotted or dashed lines larger than 

width of 1 cannot show on the screen but do print correctly. 

B X X 4.11

Merge Data The printing function no longer exits if given a wrong record # (EX: Record # too high). B X 4.11

Merge Data When printing, added ability to specify ending record # (A = All). M X 4.11

Merge Data Merge Data was not printing “Print & Slug” text inside the boxes created by “Box Responses”. B X 4.11

Version 4.11
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Merge Data Changed all Error Messages from “Data Merge” to “Merge Data” for consistency. M X X 4.11

Move Print Image The margins were not being saved correctly. B X 4.11

Properties Dialog 

Box Removed extra word “when” on Welcome Dialog Box. B X 4.11

Responses

The pull-down list of Response Object standard character choices was added to with things like "5 

Blank Bubbles" and "5 Blank Bubbles with Spaces". 

M X X 4.11

Samples Added more sample files. M X 4.11

Shading Modified shading to be 5% in sample form files. M X 4.11

ToolBar Added TOOLTIPS to Print and Spell Checker Tools. M X X 4.11

Version 4.10

Barcodes

In the font list, bar code fonts now print as their name instead of using the characters in the font 

itself. M X X 4.10

Box Responses For Magenta Office – Added a Box Responses feature.  This is already in Magenta M X 4.10

Error Messages

The warning message that tells the user that one Response Object overlaps another will only be 

given when creating Scan Template. Overlapping of Objects is allowed and can be desirable. 

M X 4.10

Error Messages

The warning message that tells the user that a Form File (.FSL) was created by the Office version 

for the standard version of Magenta and vice-versa will only be shown one time for a booklet 

instead of for each form in the booklet. M X X 4.10

Fonts

After creating a new form and putting a Timing Track on the form, if the user then started to place a 

Response Object on the form and changed the FONT, the font would revert back to ALSCAN. 

B X 4.10

Fonts

On Timing, Skunk and Response Objects, Magenta was not displaying the correct default font for 

the bubble configuration. B X X 4.10

Form ID Changed “Skunk Marks” to “Form ID” on Main Menu. M X X 4.10
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Images

A warning message was added to stop the user from using image filenames with hyphens in them. 

This causes a problem when the form is reopened. M X X 4.10

Images

Set the default Graphic directory on the Browse Dialog Box to the directory of the file and put the 

filename for an already existing graphic in the edit box. M X X 4.10

Merge Data

On a Merge Data field, if “Each entry on a separate record” was checked in the Properties Box, 

Magenta would erroneously give an error if the Segment Length was not greater than or equal to 

the Data Length. B X 4.10

Merge Data New Merge Data ability to do Segment Preprinting using a Comma/TAB Delimited File. M X 4.1

Merge Data Merging Data is now allowed in Demonstration versions. M X 4.10

Merge Data Added the ability to break on a certain field when using Merge Data and Segments. M X X 4.10

Move cursor The “Move” cursor had been modified to a more Windows standard cursor. M X X 4.10

Object Bar

Bold and Italic are now separate buttons on the Object Bar for a Response Object to be closer to 

Windows standard. M X X 4.10

Paper Size

When you adjust the paper size, Magenta now adjusts the number of Timing Marks to fit the new 

paper size. M X 4.10

Properties Dialog 

Box Added Dialog Boxes for line, box, shade and graphic objects. M X X 4.10

Properties Dialog 

Box Dialog Boxes for lines and boxes have added the ability to create any width line using any line type. M X X 4.10

Properties Dialog 

Box

Magenta now brings up the Properties Box for each new object created.  To turn off this feature, go 

to Tools/Expert Mode and select. M X X 4.10

Properties Dialog 

Box Double clicking on any object will bring the properties box for that object. M X X 4.10

Properties Dialog 

Box

Added a Properties button to the Object Bar for all object types and a Properties menu item to the 

File menu to allow easy access to the Object Dialog Boxes. M X 4.10

Timing Track For Magenta Office, removed Timing Track from menu and toolbar. M X 4.10
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Wizards Added New Form wizards for Form parameters, Timing and Skunk Marks. M X X 4.10


